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Introduction
Bluetooth® is an open specification for a cutting-edge technology that enables short-range
wireless connections between desktop and laptop computers, personal digital assistants,
cellular phones, printers, scanners, digital cameras and even home appliances — on a
globally available band (2.4GHz) for worldwide compatibility. In a nutshell, Bluetooth unplugs
your digital peripherals and makes cable clutter a thing of the past. Now you can connect
your PDA or PC to Bluetooth® enabled mobile phone with this Bluetooth® adapter.
You can access e-mail & Internet no matter where you are with just a little help from your
Bluetooth® mobile phone.
Plus, when you are back in the office, you can hook yourself up to your office network as
well as communicate with other Bluetooth®-enabled devices.
To use your Bluetooth Adapter with a Bluetooth-enabled device, you first need to install the
Bluetooth Adapter. You then need to set up the service for that device using the Bluetooth
Settings. Please see the appropriate sections in this User Guide for directions.

i
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Chapter 1
Supported profiles

Windows 98SE/ME
This Bluetooth Stack for Windows supports the following profiles.  Please note that profiles
HSP, PAN, BIP, A2DP, AVRCP and GAVDP are supported by Windows XP and Windows
2000 only.

(a) Dial-Up Network (DUN)

(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)

(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

Windows 2000/XP
(a) Dial-Up Network (DUN)

1
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(b) Fax profile (FAX)

(c) Local Access Profile (LAP)

(d) Serial Port Profile (SPP)

(e) Human Interface Devices (HID)

(f) Hard Copy Replacement Profile (HCRP)

(g) File Transfer Profile (FTP)

(h) Object Push Profile (OPP)

(i) Headset Profile (HSP)

(j) Personal Area Network (PAN)

(k) Basic Imaging Profile (BIP)

(l) Advanced Audio Distribution Profile (A2DP)

(m) A/V Remote Control Profile (AVRCP)

(n) Generic Audio Video Distribution Profile (GAVDP)

Supported languages

The Bluetooth Stack for Windows supports the following languages.
English
Danish
French
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German
Italian
Japanese
Norwegian
Spanish
Swedish

The following languages are supported by Windows XP and Windows 2000 only.
Dutch
Korean
Simplified Chinese
Traditional Chinese
Russian
Finnish
Portuguese (Brazil)

Supported operating systems

The Bluetooth Stack for Windows supports the following operating systems.
Windows 98 Second Edition
Windows ME
Windows 2000 Professional (Service Pack 3 or above)
Windows XP Professional (Service Pack 1 or above)
Windows XP Home (Service Pack 1 or above)
Windows XP Tablet PC Edition
Windows XP Media Center Edition

Limitations

(a) External Bluetooth drivers cannot be "signed drivers" to receive Microsoft WHQL logo.
Therefore, Microsoft's "Unsigned driver" warning messages may pop up during the software
installation, Bluetooth headset, mouse or keyboard setup. Please install the drivers and then
follow the on-screen instructions.
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(b) On Swedish Windows XP, an error message (error code = 633) may be seen during dial-
up. Please update the operating system to Windows XP Service Pack 2 or refer to Microsoft
knowledge base #831717.

(c) Windows XP fast user switch is not supported.  When switching to another user, the
Bluetooth Manager is not launched.  Please log off before switching to another user.

(d) If "automatic FAX receiving" is enabled on Microsoft FAX manager, and if DUN, FAX, or
LAP profile icon is registered on Bluetooth Settings, and then Bluetooth's "resume from
standby" may take a couple of minutes to turn on.

(e) Windows 98 Second Edition: If the "Install New Modem" dialog pops up when setting up
a Bluetooth modem, mobile phone, or access point, please choose "Don't detect my modem;
I will select from a list".  Otherwise, the system may freeze during the modem detection.  If
the manual for your Bluetooth device does not specify a modem driver, then please select
"Standard 33600bps modem".

(f) Before connecting or disconnecting a Bluetooth headset, please exit any voice or sound-
related applications (e.g. Windows Messenger, Windows Media Player).  The audio input
and output may not be switched properly if those applications are running.  This same
precaution is important prior to system standby, hibernate or shutdown, and prior to turning
off or unplugging the primary Bluetooth device.
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Chapter 2
Setup for Windows 98SE/ME/2000/XP

Installing Bluetooth software for Windows
1. Do not plug the Bluetooth device into your computer yet. You need to install the software

first.
2. Insert the installation CD into the CD drive. The CD should start automatically and the

Language Selection screen should appear. (If it does not, double-click the My
Computer icon on your desktop and then, in the My Computer window, double-click the
Zoom icon.)

3. In the Language Selection window, choose your language.
4. In the next window, select Installation Wizard then choose the name of your Bluetooth

device.
5. Follow the prompts to install the software. Note: Please accept the licensing agreement

when prompted.
6. Windows XP/2000 users only: If the Driver Signature Notice message box appears,

click OK.
7. When prompted, plug the Bluetooth device into your computer. (If you are using the USB

Adapter, you may find it helpful to connect the supplied USB cable between the USB
Adapter and the USB port.) Then click OK to continue the installation.

8. When the installation is complete, click Finish, then Yes. Your computer will shut down
and restart.

9. To use your Bluetooth USB Adapter or PC Card with another Bluetooth device, you need
to set up the service for that device using the Bluetooth Settings. Please see the
additional chapters in this Bluetooth USB Adapter User Guide for directions.

2
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Chapter 3
Basic settings

Methods for registering new devices using the Bluetooth Utility shall now be described.
A Bluetooth mouse shall be connected and set up using [Bluetooth Settings] as an example.
[Bluetooth Settings] provides two set-up methods: "Express Mode" and "Custom Mode."

− Express Mode
[Bluetooth Settings] will automatically detect and register services. If several services
(profiles) are supported by the device the service that has been set to the highest priority
shall be selected and registered.
Express Mode is normally recommended for device set-up.

− Custom Mode
After having been detected, the services supported by the device are displayed as a list,
from which you can select the desired function(s).
Custom Mode must be used to set up a device if, for example, you wish to use a modem
station to send a fax (because in Express Mode, the DUN profile will be automatically
selected since it has a higher priority than the FAX profile).

The differences between setting up the same device (a Bluetooth mouse) using Express
Mode and Custom Mode are described on the following pages.

Express Mode Set-up

Starting Bluetooth Settings

1. Click [Start]![All Programs]![Bluetooth]![Bluetooth Settings].
(Under Windows 2000, click [Start]→[Programs]→[Bluetooth]→[Bluetooth Settings].)

3
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Note

− The same result can be achieved by right-clicking on the Bluetooth icon in the task
tray and selecting [Bluetooth Settings] from the menu that appears.

The [Bluetooth Settings] window below will appear when other devices have already
been registered.

Please click the [New Connection] button to open the [Add New Connection Wizard] window.
If no devices have been registered yet, please proceed directly to "Detecting Bluetooth
Devices."

Detecting Bluetooth devices

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.
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1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Express Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on the
[Next] button.

Searching for Bluetooth devices will start.

When the device has been detected, the name and address of the device will appear in the
[Add New Connection Wizard (Select Device)] window.
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Note
− If no device is found, please confirm that the device has been made connectable

via Bluetooth, and click on the [Update] button.
− A further device search will be performed.

Detecting services

1. Select the device name from [Device List] and click on the [Next] button.
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Bluetooth device detection will commence.

Note
− If several services (profiles) are supported by the device, the service that has

been set to the highest priority shall be automatically selected and set up in
Express Mode. Please use Custom Mode if you wish to select desired services
manually.

− When a service has been detected, a window prompting you to enter the
Bluetooth passkey (PIN code) may appear. Please enter the passkey and click on
the [OK] button. Typically, the PIN code is on the Bluetooth device.

− If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please
perform the passkey entry process again.

A message will appear prompting you to prepare the device for connection.
2. Click on the [OK] button.
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Note
− When the settings information has been registered, a window prompting you to

enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

− If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please
perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

3. Select the type and name of the icon to be displayed once the device has been
registered, and click on the [Next] button.
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Note
− If you wish to change the icon, please click on the [Change Icon] button and select

your preferred icon from the list that appears.

Registering settings information
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The [Add New Connection Wizard (Completing the Add New Connection Wizard)] window
will appear.

1. Click on the [Finish] button

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.
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Custom Mode Set-up

Starting Bluetooth Settings

1. Click [Start]![All Programs]![Bluetooth]![Bluetooth Settings].
(Under Windows 2000, click [Start]→[Programs]→[Bluetooth]→[Bluetooth Settings].)

Note
− The same result can be achieved by right-clicking on the Bluetooth icon in the task

tray and selecting [Bluetooth Settings] from the menu that appears.

The [Bluetooth Settings] window below will appear when other devices have already
been registered.
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Please click the [New Connection] button to open the [Add New Connection Wizard]
window. If no devices have been registered yet, please proceed directly to "Detecting
Bluetooth Devices."

Detecting Bluetooth devices

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] window
will appear.

1. Switch the device power ON to make it connectable via Bluetooth.

2. Confirm that [Custom Mode] has been selected in the [Add New Connection
Wizard (Welcome to the Add New Connection Wizard)] window, and click on the
[Next] button.

Searching for Bluetooth devices will start.
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When the device has been detected, the name and address of the device will appear in
the [Add New Connection Wizard (Select Device)] window.

Note
− If no device is found, please confirm that the device has been made connectable via

Bluetooth, and click on the [Update] button. A further device search will be
performed.
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Detecting services

1. Select the device name from [Device List] and click on the [Next] button.

Bluetooth device detection will commence.
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Note
− When a service has been detected, a window prompting you to enter the

Bluetooth passkey (PIN code) may appear. Please enter the passkey and click
on the [OK] button. Typically, the PIN code is on the Bluetooth device.

− If you have not entered your Bluetooth passkey after a certain amount of time
has passed, the connection process will be cancelled for security reasons.
Please perform the passkey entry process again.

− If you try to register a device that has already been registered, the following
message will appear, and you will not be able to proceed with further operation.
Please click on the [OK] button to close the message.
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The services supported by the device will be displayed.
2. Select the desired service and click on the [Next] button.

Note
− When a device supports several services

If the device supports several services, you can use Custom Mode to manually
select the services (profiles) you wish to use from the list that appears under
[Select Services].

Example: List of wireless modem station services
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If Express Mode is used to perform the set-up, the highest-priority service in the
device will be automatically selected and configured.

3. Click on the [OK] button.

Note
− When the settings information has been registered, a window prompting you to

enter your Bluetooth passkey (PIN code) may appear. Please enter your passkey
and click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

− If you have not entered your Bluetooth passkey after a certain amount of time has
passed, the connection process will be cancelled for security reasons. Please
perform the passkey entry process again.

The [Add New Connection Wizard (Connection Name Setup)] window will appear if a
service has been properly detected.

4. Select the type and name of the icon to be displayed once the device has been
registered, and click on the [Next] button.



25

Note
− If you wish to change the icon, please click on the [Change Icon] button and select

your preferred icon from the list that appears.
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Registering settings information

The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.
1. Click on the [Finish] button

The [Bluetooth Settings] window will appear.
The icons of the registered devices will appear, and the devices will be ready to use.
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Chapter 4
Making the most of your Bluetooth device

Connecting to the internet

Connecting to the internet using a modem station
Setting up the modem station

1. Turn on the wireless modem station.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], and

then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.

4
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.
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The [Add New Connection Wizard (Searching for Services)] window will appear.

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.
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5. If you are connecting to a wireless modem station for the first time, enter the
passkey for the modem station under [Bluetooth Passkey (PIN code)], and then
click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Once the program has finished searching for the devices, the [Add New Connection
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.

Note
− Please refer to the modem or mobile phone instruction manual for further detail or

mobile phone instruction manual for further details on initialization commands.
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7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and then
click on the [Finish] button.

Important
The sample entries shown in the window are provided solely for purpose of
explanation. Please use your own telephone number, ID and password according
to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Important
A connection will be automatically established with the modem station if COM Auto
Connect is available. If COM Auto Connect is not available, please manually
connect to the modem station.

The following message will appear once you have connected to the Internet.
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4. End the connection

The window below will appear if you double-click on the icon in the task bar.

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

Note
− You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection destination
icon, and then click on [Connect] from the menu that appears.
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A window indicating that the connection is being established will appear.

If the connection has been established successfully, the connection icon and task tray
will appear as shown below.
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You will be able to browse Web pages using your browser and send and receive e-
mail. 

Important
Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

The following message will appear. Click on the [Yes] button.

When the icon appears as shown below, the connection will have ended.
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Connecting to the internet using a mobile telephone
Important

− In order to connect to the Internet, you must have already signed up with a
provider and obtained a connection ID and password. Please ensure you have
confirmed the ID, password and telephone number of your provider's access
point before you begin the set-up process.

− A Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process. Typically, the PIN code is on the Bluetooth device.

Configuring a mobile telephone for use a modem
1. Turn on the mobile phone, and set it to be connectable via Bluetooth.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], and

then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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The [Add New Connection Wizard (Searching for Services)] window will appear.

Once a service has been detected successfully, connection to the device and COM
port creation will be performed automatically, after which the [Add New Connection
Wizard (Modem Settings)] window will appear.
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5. If you are connecting to a mobile telephone for the first time, enter the passkey
for the wireless modem station under [Bluetooth Passkey (PIN code)], and then
click on the [OK] button. Typically, the PIN code is on the Bluetooth device.

Once the program has finished searching for the devices, the [Add New Connection
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button.

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the
initialization commands in the following window, and then click on the [OK] button.
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7. Enter the connection name (optional), telephone number (of your provider's
access point), user name and password (as issued by your provider), and then
click on the [Finish] button.

Important
The sample entries shown in the window are provided solely for purpose of
explanation. Please use your own telephone number, ID and password according
to the arrangement with your provider.

The settings will be registered, and an icon will appear in the [Bluetooth Settings]
window.
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Connecting to the Internet
1. Start your browser, e-mail application or other application

Important
Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. Enter the URL of the Web page you wish to display and then press the [Enter]
key, or use the e-mail tool to send/receive items or perform other activities.

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

Important
A connection will be automatically established with the modem station if COM Auto
Connect is available. If COM Auto Connect is not available, please manually
connect to the mobile telephone .

The following message will appear once you have connected to the Internet.
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4. End the connection

The window below will appear if you double-click on the icon in the task bar.

Please click on the [Disconnect] button when you want to disconnect from the Internet.

Alternatively, please right-click on the icon, and then click on [Disconnect].

Note
− You can start an application to make an automatic connection to the Internet, but

you can also make a manual connection using the connection destination icon.
The procedure is described below.

1. From the [Bluetooth Settings] window, right-click on the connection destination
icon, and then click on [Connect] from the menu that appears.
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A window indicating that the connection is being established will appear.

If the connection has been established successfully, the connection icon and task tray
will appear as shown below.
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You will be able to browse Web pages using your browser and send and receive e-
mail. 

Important
Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application).

2. End the connection
Right-click on the icon, and then click [Disconnect] to end the connection.

The following message will appear. Click on the [Yes] button.

When the icon appears as shown below, the connection will have ended.
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Connecting to a network[LAN]

Connecting to a LAN using an access point[LAP]
Setting up the access point

Important
− The access point must have been started and a normal connection already

established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access
point.

− A Bluetooth passkey (PIN code) is required for you to connect to the access
point. Please make a note of your Bluetooth passkey before you start the set-up
process. Typically, the PIN code is on the Bluetooth device.

1. Turn on the access point, and confirm that a connection has been established
with the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], and

then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next]
button.
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

4. Select the device name of the access point from [Device List], and then click on
the [Next] button.
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You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the
[OK] button.

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Create Connection Destination)] window will
appear.

6. Enter the connection name, user name and password, then click on the        
[Next] button.
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Note
− The user name and password are entered here to allow you to connect to the

access point.

The [Add New Connection Wizard (Confirm Dial-up Settings)] window will appear.
7. Click on the [Confirm Settings] button.
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8. Configure the connection method, and then click on the [OK] button.
Set the connection destination used for the LAN connection set up in (6) above as
the default connection destination, and then select "Always dial my default
connection."

9. Click on the [Next] button.
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10. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

11. Click on the [Finish] button.

The access point icon will be registered in the [Bluetooth Settings] window.



52

Connecting to a LAN(LAP)
1. Right-click on the connection icon in the [Bluetooth Settings] window, and then

click on [Connect].

2. Confirm that "Direct connection" has been selected under [Connection
Destination], and then click on the [Connect] button
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A connection will be initiated.

Note
− This is an example of what happens when you use "Direct connection" as a

connection name under "Connect to access point." If a name different from the
connection name is used, that name will appear under [Connection Destination]. 

− Please simply click on [Settings] if no user name or password have been entered
(i.e., if those fields have been left blank)

− Please change the connection destination if a different connection name (for a
dial-up connection) appears in [Connection Destination].

Once you connect to the network, Internet Explorer will start automatically, and you
will be able to exchange data with other computers on the network.

Note
Please follow the procedure below if you need to set up a proxy server to connect
to the Internet (the following procedure is not necessary if the PC you are going to
use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...] button.
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3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.
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Connecting to a LAN using an access point[PAN]
Setting up the access point
Important

− The access point must have been started and a normal connection already
established to the network before the access point is set up. Please refer to the
access point instruction manual for information on how to set up the access point.

− A Bluetooth passkey (PIN code) is required for you to connect to the access point.
Please make a note of your Bluetooth passkey before you start the set-up
process. Typically, the PIN code is on the Bluetooth device.

1. Turn on the access point, and confirm that a connection has been established with
the network.

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings],

and then click on [New Connection] from the active [Bluetooth Settings] window.

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button.
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will
appear.

4. Select the device name of the access point from [Device List], and then click on the
[Next] button.
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You will be asked for the Bluetooth passkey in the window that appears.

5. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the [OK]
button.

Service detection and COM port creation will be performed automatically.
The [Add New Connection Wizard (Connection Name Settings)] window will appear.

6. Enter the type and name of the icon displayed after registration, and then click on
the [Next] button. Please click on the [Next] button if you are satisfied with the
settings.
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The [Add New Connection Wizard (Completing the Add New Connection Wizard)]
window will appear.

7. Click on the [Finish] button.
The access point icon will be registered in the [Bluetooth Settings] window.

This will complete the access point set-up process.

Connecting to a LAN(PAN)
1. Right-click on the connection icon in the [Bluetooth Settings] window, and then

click on [Connect].
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2. Enter the passkey under [Bluetooth Passkey (PIN code)], and then click on the
[OK] button.

A connection will be initiated.

Note
Please follow the procedure below if you need to set up a proxy server to connect
to the Internet (the following procedure is not necessary if the PC you are going to
use has already been set up as a proxy server).

1. Select [Internet Options...] from the [Tools] menu in Internet Explorer.

The [Internet Options] window will appear.

2. Click on the [Connections] tab, and then click on the [Settings...] button.
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3. Enter the IP address and port number of the proxy server under [Proxy
Server], and then click on the [OK] button.

Sending files
You can send and receive files other than business card data with a Bluetooth-enabled PC
or PDA. Use "File transfer" in the Bluetooth Information Exchanger to exchange files.

Note
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− The same operations will be valid as long as the PC and PDA support the FTP
profile

− "File transfer" cannot be used to send or receive business card data. Please
instead use "Object Push" to perform these activities.

Exchanging files with a PC or PDA
Sending files to a PC or PDA

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
Alternatively, opening Explorer and clicking on the Bluetooth Information Exchanger
folder will produce the same result.

3. Double-click on the [File transfer] icon.

A list of devices will appear in the [File transfer] window.
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Note
− If the desired device does not appear in the list, please confirm that the device has

been turned on, and then select [Bluetooth]→[Search Devices].
A device search will be performed.

− You can also use "Image transfer" when sending individual image files.
4. Use the mouse to drag and drop the file you wish to send over the destination

icon.
In this case, the file will be sent to a PC named "PC-1".
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Note
− When using "File transfer", you can send individual files as well as entire folders.

5. Confirm that the file is being sent.
The file will be sent to the PC.

Note
− When sending files using "File transfer", a message requesting permission to

receive the files may appear on the destination (receiving) device. The content of
the message will vary with the Bluetooth software installed on the destination
device, so please be sure to follow the instructions provided.
If you are using the Bluetooth Utility, a message similar to the one below will
appear.

If the file has been sent successfully, the message below will appear.
Please click on the [OK] button.

The message below will appear if the file transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Note
− Files that have been sent will be saved in a file transfer shared folder on the

destination device.
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− Additionally, with "File transfer", you can open the shared folder on the destination
device using Explorer, specify a subfolder, and then send the file there.

You can use Properties in the Bluetooth Information Exchanger to change the
location of the "Shared folder" on the hard drive.

Receiving files from a PC or PDA
Your PC is able to receive files that have been saved in the shared folder on the destination
PC or PDA. Received files will be saved in the shared folder under "File transfer".

1. Turn on the PC or PDA.
Confirm that a Bluetooth connection has been enabled before proceeding.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.
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3. Double-click on the [File transfer] icon

A list of devices will appear in the [File transfer] window.

In this case, the file will be received from the PDA named "My Mobile".
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4. Double-click on the [PDA-1] icon
The file saved in the shared folder in "My Mobile" will appear.

5. Right-click on the file you wish to receive, and then select "Receive file".

The file will be received from a PDA.

Note
− With "File transfer", you can send individual files as well as entire folders.

Please right-click on the folder you wish to receive, and select "Receive folder".

Subsequent operations should be performed in the same manner as when receiving
individual files.

If the file has been received successfully, the message below will appear.
Please click on the [OK] button.
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The message below will appear if the file transmission was unsuccessful. Please click
on the [OK] button to close the message, and repeat the procedure.

Note
− The received file will be saved in the "Shared folder" under "File transfer" in the

Bluetooth Information Exchanger

You can use Properties under the Bluetooth Information Exchanger to specify the
location of the "Shared folder" on the hard drive.

Sending images to a mobile telephone 
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.
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Note
− The mobile telephone must support the BIP profile.
− The image file”(*.bmp)(*.jpg,*.jpeg)(*.png)” formats can be sent and received using

"Image transfer".
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

3. Double-click on the [File transfer] icon.
A list of devices will appear in the [File transfer] window.
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4. Drag and drop the file you wish to send over the destination icon.
In this case, the image will be sent to a mobile telephone named "BT-Phone-1".

The image will be sent.
If the image has been sent successfully, the message below will appear.
Please click on the [OK] button.
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The message below will appear if the image transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.
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Exchanging business card data with a PC or PDA
You can exchange business card data with a Bluetooth-enabled PC or PDA.
Business card data are exchanged using "Object Push" under Bluetooth Information
Exchanger.

Selecting a business card and sending it to a PC or PDA
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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Note
− If the desired device does not appear in the list, please confirm that the device has

been turned on, and then select [Bluetooth]→[Search Devices].
A device search will be performed.

4. Use the mouse to drag and drop the business card you wish to send over the
destination icon
In this case, the business card will be sent to a PC named "PC-1".

Note
− When you try to send a business card, a message requesting permission to

receive the card may appear on the device belonging to the other party (i.e., on
the receiving end). The content of the message will vary with the Bluetooth



73

software installed on the destination device, so please be sure to follow the
instructions provided. If you are using the Bluetooth Utility, a message similar to
the one below will appear.

If the business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Selecting your personal business card
You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.
1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.
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Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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Note
− If the desired device does not appear in the list, please confirm that the device has

been turned on, and then select [Bluetooth]→[Search Devices].
A device search will be performed.

4. Right-click on the destination icon, and then click on [Send business card To].
In this case, your personal business card will be sent to a PC named "PC-1".

The business card will be sent.

Note
− When you try to send a business card, a message requesting permission to

receive the files may appear on the device belonging to the other party (i.e., on the
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receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided. If you are using the Bluetooth Utility, a message similar to the one below
will appear.

− Business cards that have been sent will be saved in the Inbox of the destination
party.

If your business card has been sent successfully, the message below will appear.
Please click on the [OK] button.

The message below will appear if the business card transmission was unsuccessful.
Please click on the [OK] button to close the message, and repeat the procedure.

Note
− Data that has been sent will be saved in a folder for exchanged business cards on

the destination device.
Receiving a business card from another party
You can prepare a business card bearing your name and other details such as your
company and telephone numbers, and then send it to another party.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.
1. Turn on the PC or PDA.
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2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.
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Note
− If the desired device does not appear in the list, please confirm that the device has

been turned on, and then select [Bluetooth]→[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party whose card you wish to acquire, and then
click on [Receive business card]
In this case, the business card of the other party will be acquired from a PC named
"PC-1".

The business card will be received.
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Exchanging business cards
Simultaneously exchange your business card with one belonging to another party.

1. Turn on the PC or PDA.

2. Double-click on the Bluetooth Information Exchanger icon on the Desktop.

Note
− Alternatively, opening Explorer and clicking on the Bluetooth Information

Exchanger folder will produce the same result.

3. Double-click on the [Object Push] icon.
A list of devices will appear in the [Object Push] window.



80

Note
− If the desired device does not appear in the list, please confirm that the device has

been turned on, and then select [Bluetooth]→[Search Devices].
A device search will be performed.

4. Right-click on the icon of the party with whom you wish to exchange business
cards, and then click on [Object Push].
In this case, the business cards will be exchanged with a PC named "PC-1".

The business card from the party who executed the "Exchange business cards"
command will be sent first.
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Note
− When you try to send a business card, a message requesting permission to

receive the files may appear on the device belonging to the other party (i.e., on the
receiving end). The content of the message will vary with the Bluetooth software
installed on the destination device, so please be sure to follow the instructions
provided.
If you are using the Bluetooth Utility, a message similar to the one below will
appear.
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Synchronizing data with a PDA
When you connect via Bluetooth instead of with a standard cable, you will always be able to
synchronize your data without the hassle of having to connect the cable.
Connecting using ActiveSync
Preparing the PC

1. On the PC, click on [Start]![All Programs]![Microsoft ActiveSync].
The initial ActiveSync set-up window will appear.
It is assumed in the explanation below that no ActiveSync connections have been
established with other devices.

2. Click [File]![Connection Settings].
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The [Connection Settings] window will appear.

3. Place a check next to [Allow serial cable or infrared connection to this COM
port], and then select "COM7".

Note
− In the standard set-up, the port is configured to "COM7" (refer to Steps (3) and (4)

under "Preparing the PDA" below). When using a different port, please also
change the port number selected in this window

Preparing the PDA
1. Tap on the Bluetooth icon in the bottom right of the screen.
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Important
The graphic above shows an example of a PDA operating window.
The connection procedure may be different depending on the manufacturer or
model of PDA you use. Please refer to the product instruction manuals for further
details.

The [Bluetooth Settings] window will open.
The message "Connection not registered" will appear if no Bluetooth device has been
registered.

Please tap on [OK] to close the message.
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2. Double click on [Tools]![Search for peripheral components].

The application searches for nearby Bluetooth devices.

3. Tap and hold on the destination PC icon, and then select [Update Services].

A search for services will be carried out, and then a list of service names and their
connection status will appear as list in the lower window.
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4. Tap and hold on "COM7" from the list of service names, and then select
"Register ActiveSync".

5. Tap [OK] in the confirmation message window.
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An ActiveSync connection will be initiated.

Establishing a partnership between ActiveSync and a PDA
Once a connection has been successfully established with a PDA, the procedure for
establishing a partnership with the PDA will be started by the ActiveSync application on the
PC.
Performing this set-up procedure will enable data to be synchronised between your PC and
PDA.

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard
partnership", and then click on the [Next] button.
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The [New Partnership (Specify Data Synchronisation Method)] window will appear.

2. Select "Synchronise with this PC", and then click on the [Next] button.

The [New Partnership (Select Synchronisation Settings)] window will appear.

3. Select the type of information to be synchronised between your PC and PDA,
and then click on the [Next] button.



89

The [New Partnership (Completing Setup)] window will appear.

4. Click on the [Finish] button.

When you click on the [Finish] button, ActiveSync will begin to synchronize your
information.

[Confirming changes]
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(Synchronization process)

[Synchronization complete]

While the ActiveSync connection is active, synchronization will be performed
whenever information is changed on either the PC or the PDA.

Once a partnership has been established, every time you start your PC (and PDA)
thereafter, a Bluetooth connection will be opened and ActiveSync will synchronize
your information.

Finishing an ActiveSync connection
Tap and hold on "COM7" in the Bluetooth Settings window, and select [ActiveSync Release].
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Cancelling a partnership
1. Click on [File]!"Delete partnership".
2. Click on the [Yes] button when the confirmation message appears.
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Fax transmission

Using a modem station for fax transmission
Important

− Please refer to the modem station instruction manual for information on how to
connect the station to a telephone line.

− Please ensure that any drivers used to connect the PC to the modem have been
installed.

− A Bluetooth passkey (PIN code) is required for you to connect to the modem
station. Please make a note of your Bluetooth passkey before you start the set-
up process. Typically, the PIN code is on the Bluetooth device.

− A fax application is required for you to be able to send and receive faxes. The
description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.
If you are going to use a commercially available fax application, then please
refer to the manual that came with the application for information on how to
send and receive faxes.

Setting up the modem station
1. Turn on the wireless modem station.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], and

then click on [New Connection] from the active [Bluetooth Settings] window.
− The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]

window will appear.
3. Select [Custom Mode], and then click on the [Next] button.
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will appear.

Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the wireless modem station from [Device List], and
then click on the [Next] button.
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The [Add New Connection Wizard (Searching for Services)] window will appear.

5. If you are connecting to the wireless modem station for the first time, enter the
passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and
then click on the [OK] button.
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Once the program has finished searching for the services, the [Add New 
Connection Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button.

The [Add New Connection Wizard (Select COM Port)] window will appear.

7. Check [Use default COM port], and then click on the [Next] button.
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Note
− The modem station will be installed to the grayed-out COM port displayed under

[Assignment of COM Port] in this window. You will be specifying this COM port in
Step (3) of "●Installing a Modem", so please write it down for future reference.

The [Add New Connection Wizard (Connecting to Remote Device)] window will appear.

The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem Options]
windows will appear.
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8. Click on the "Add..." button in the [Phone and Modem Options] window.
The [Add New Hardware Wizard (Install New Modem)] window will appear.
Install the modem by following the instructions in the windows that follow.

Installing a modem
The [Add New Hardware Wizard (Install New Modem)] window will appear.

1. Check [Don't detect my modem; I will select it from a list], and then click on the
[Next] button.
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A list of modem manufacturers and models will appear.

2. Select the desired wireless modem from under [Manufacturer] and [Models],
and then click on the [Next] button.

Note
− If you have not yet installed a modem driver, click on the "Use Device" button to

install one from this window.
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− If no modem drivers appear, please select "(Standard Modem Types)" and
"Standard 33600 bps modem."

A window will appear where you can specify the port to which you can install the modem.
3. Select "Selected Port", specify the COM port to which the modem will be

installed, and then click on the [Next] button.

Important
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Please specify the COM port displayed in the window pertaining to Step (7) under
"●Setting up the modem station."

4. Click on the [Continue] button.
The wizard will display the following window by design, but you may disregard it and
click on the "Continue" button.

A window will appear indicating that the modem installation is complete.

5. Click on the [Finish] button.
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6. Confirm that the configured modem has been added to the list in the [Phone
and Modem Options] window, and then click on the [OK] button.

The [Next] button will be enabled on the [Add New Connection Wizard (Modem 
Settings)] window.

7. Click on the [Next] button on the [Add New Connection Wizard (Modem
Settings)] window.
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The [Add New Connection Wizard (Connection Name Settings)] window will appear.

8. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.
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9. Click on the [Finish] button.
The settings will be registered, and the icon will appear in the [Bluetooth Settings]
window.

Setting fax information
Configure send/receive settings and register fax information.

1. Select [Start]![Control Panel], and then double-click on the [Printers and Other
Hardware] icon.

Note
− If the control panel is displayed in "Classic view", and you use Windows 2000,

please start from Step (2).
2. Double-click on the [Printers and Faxes] icon.

The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window.



104

A window showing installed programs will appear, and a Fax icon will have been 
created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window.
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If you have not yet configured a fax device, the [Fax Configuration Wizard] window will
appear. In the window you can enter settings pertaining to the sender (yourself).

Note
− If the fax configuration information has already been registered, the [Send Fax

Wizard] window, which can be viewed under "Sending a fax" below, will appear
instead of the [Fax Configuration Wizard] window.

5. Enter the sender information, and click on the [Next] button
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Note
− The sender information that you configure here will be automatically appended as

header information when you send a fax.
6. Select a device to be used for fax transmissions, enable the device for sending

or receiving, and then click on the [Next] button

Note
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− If [Enable Receive] is selected, the device will be on standby for receiving faxes
even if it is not sending or receiving anything, and therefore will be in continuous
connection to the wireless modem (when COM Auto Connect is on). Please
decide whether to select this option based on the desired objective and/or
frequency of transmission.

7. Click on the [Next] button.
It is important that you do not change the transmitter subscriber identification.

8. Click on the [Finish] button.
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Setting fax information
Important

The Fax service must be enabled for sending in order for you to send a fax.
Please refer to "Using a wireless modem station" under "Troubleshooting" for how
to change the send and receive settings once the service has been configured.

1. Double-click on the [Fax] icon in the Control Panel.
The [Fax Console] window will appear.

2. In the [Fax Console] window, click [File]→[Send fax].
The [Send Fax Wizard (Starting the Send Fax Wizard)] window will appear.

3. Click on the [Next] button.
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The [Send Fax Wizard (Recipient Information)] window will appear.

4. Enter the name and fax number of the destination party, and then click on the
[Next] button.

The [Send Fax Wizard (Preparing the Cover Page)] window will appear.
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5. Specify the cover page template, subject line, and note (body text), and then
click on the [Next] button.

The [Send Fax Wizard (Schedule)] window will appear.

6. If you wish to send the fax immediately, select "Now", and then click on the
[Next] button.
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The [Send Fax Wizard (Completing the Send Fax Wizard)] window will appear.

7. Confirm the destination information and transmission details, and then click on
the [Finish] button.

The software will automatically dial the number and send the fax.
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Once the fax has been sent, Fax Monitor will revert to standby mode.

Receiving a fax
1. When a fax arrives, the Fax Monitor will start automatically as the fax is

received.

Once the fax has been received, the Fax Monitor will revert to standby mode.

Note
− If you have enabled manual fax reception, the message below will appear when a

fax arrives.

Click on the message with your mouse to receive the fax.
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2. Double-click on the [Fax] icon in the Control Panel.
The [Fax Console] window will appear.

3. In the [Fax Console] window, double-click on the fax that has arrived.
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Using a mobile telephone for fax transmission
Important

− Please ensure that any drivers used to connect the PC to the mobile telephone
have been installed.

− Bluetooth passkey (PIN code) is required for you to connect to the mobile
telephone. Please make a note of your Bluetooth passkey before you start the
set-up process. Typically, the PIN code is on the Bluetooth device.

− A fax application is required for you to be able to send and receive faxes. The
description below is based on a example using Microsoft Fax, which is installed
with Windows XP as standard.

Setting up the mobile telephone
1. Turn on the mobile telephone, and set it to be connectable via Bluetooth.

2. Right-click on the Bluetooth icon in the task tray, and then click on [Add New
Connection].

Note
− Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], and

then click on [New Connection] from the active [Bluetooth Settings] window.
− The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]

window will appear.

3. Select [Custom Mode], and then click on the [Next] button.



116

The [Add New Connection Wizard (Searching for Bluetooth devices)] window will appear.

Once the program has finished searching for the devices, the [Add New 
Connection Wizard (Select Device)] window will appear.

4. Select the device name of the mobile telephone from [Device List], and then
click on the [Next] button.
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The [Add New Connection Wizard (Searching for Services)] window will appear.

5. If you are connecting to the mobile telephone for the first time, enter the
passkey for the device from the [Bluetooth Passkey (PIN Code)] window, and
then click on the [OK] button.
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Once the program has finished searching for the services, the [Add New 
Connection Wizard (Select Service)] window will appear.

6. Select "Fax" under [Select Service], and then click on the [Next] button.

The [Add New Connection Wizard (Select COM Port)] window will appear.

7. Check [Use default COM port], and then click on the [Next] button.
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Note
− The mobile telephone will be installed to the grayed-out COM port displayed under

[Assignment of COM Port] in this window. You will be specifying this COM port in
Step (3) of "●Installing a Modem", so please write it down for future reference.

The [Add New Connection Wizard (Connecting to Remote Device)] window will
appear.
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The [Add New Connection Wizard (Modem Settings)] and [Phone and Modem Options]
windows will appear.

8. Click on the "Add..." button in the [Phone and Modem Options] window.
The [Add New Hardware Wizard (Install New Modem)] window will appear.
Install the modem by following the instructions in the windows that follow.

Installing a modem
The [Add New Hardware Wizard (Install New Modem)] window will appear.

1. Check [Don't detect my modem; I will select it from a list], and then click on the
[Next] button.
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A list of modem manufacturers and models will appear.

2. Select the desired mobile telephone from under [Manufacturer] and [Models],
and then click on the [Next] button.

Note
− If you have not yet installed a mobile telephone driver, click on the "Use Device"

button to install one from this window.
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− If no mobile telephone drivers appear, please select "(Standard Modem Types)"
and "Standard 33600 bps modem."

A window will appear where you can specify the port to which you can install the modem.
3. Select "Selected Port", specify the COM port to which the modem will be

installed, and then click on the [Next] button.

Important
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Please specify the COM port displayed in the window pertaining to Step (7) under
"●Setting up the modem station."

4. Click on the [Continue] button.
The wizard will display the following window by design, but you may disregard it and
click on the "Continue" button.

A window will appear indicating that the modem installation is complete.

5. Click on the [Finish] button.
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6. Confirm that the configured modem has been added to the list in the [Phone
and Modem Options] window, and then click on the [OK] button.

The [Next] button will be enabled on the [Add New Connection Wizard (Modem 
Settings)] window.

7. Click on the [Next] button on the [Add New Connection Wizard (Modem
Settings)] window.
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The [Add New Connection Wizard (Connection Name Settings)] window will appear.

8. Enter the type and name of the icon displayed after registration, and then click
on the [Next] button.
Please click on the [Next] button if you are satisfied with the settings.

The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
window will appear.
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9. Click on the [Finish] button.
The settings will be registered, and the icon will appear in the [Bluetooth Settings]
window.

Setting fax information
Configure send/receive settings and register fax information.

1. Select [Start]![Control Panel], and then double-click on the [Printers and Other
Hardware] icon .

Note
− If the control panel is displayed in "Classic view", and you use Windows 2000,

please start from Step (2).
2. Double-click on the [Printers and Faxes] icon.

The [Printers & Faxes] window will appear.

3. Click on "Install a local fax printer" in the [Printers and Faxes] window.
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A window showing installed programs will appear, and a Fax icon will have been 
created in the [Printers and Faxes] screen.

4. Click on "Send a fax" under "Printer Tasks" on the left side of the window.
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If you have not yet configured a fax device, the [Fax Configuration Wizard] window will
appear. In the window you can enter settings pertaining to the sender (yourself).

Note
− If the fax configuration information has already been registered, the [Send Fax

Wizard] window, which can be viewed under "Sending a fax" below, will appear
instead of the [Fax Configuration Wizard] window.

5. Enter the sender information, and click on the [Next] button
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Note
The sender information that you configure here will be automatically appended as
header information when you send a fax.

6. Select a device to be used for fax transmissions, enable the device for sending
or receiving, and then click on the [Next] button

Note
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− If [Enable Receive] is selected, the device will be on standby for receiving faxes
even if it is not sending or receiving anything, and therefore will be in continuous
connection to the wireless modem (when COM Auto Connect is on). Please
decide whether to select this option based on the desired objective and/or
frequency of transmission.

7. Click on the [Next] button.
It is important that you do not change the transmitter subscriber identification.

8. Click on the [Finish] button.
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Please refer to the same procedure of “Sending a fax” and “receiving a fax” in the “Using a
Modem Station for Transmission” section.

Using a Bluetooth-compatible camera
Connecting the camera

1. Click on [Start ]![All Programs]![Bluetooth]![Remote Camera].

Note
− In Windows 2000, click on [Start]→[Programs]→[Bluetooth]→[Remote Camera].

The [Remote Camera] window will appear.

2. Turn on the camera, and set it to be connectable via Bluetooth.

Note
− Different cameras are operated in different ways, depending on the manufacturer

and model used. Please refer to the instruction manual for further details on how
to operate your camera.

3. Click on the [Camera Search...] button.
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The camera will be detected and its icon displayed.

4. Right-click on the camera icon, and select [Connect].
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The camera will be connected, and images from the camera will appear on-screen.

Taking a signal picture
By placing the mouse cursor over the on-screen image, the camera's operating window will
appear.
You can operate the camera from this window.

1. Click on the  button in the operating window.
A single image will be captured and sent to the PC.
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Taking several consecutive frames

1. Click on the  button in the operating window.
A succession of images will be captured and sent to the PC.

Note
− The remote camera shutter cannot be operated while the camera is connected to

the PC.
− The number of consecutive pictures taken can be set to anywhere between 2 and

16.
2. In the [Remote Camera] window, click on [Bluetooth]→[Properties]![Consecutive

Image Settings].
3. Click on the [<][>] buttons to select the number of consecutive images to be

captured.
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Note
− Images are not only sent to the PC, but are stored in the camera's on-board

memory as well. Please be aware of the remaining memory capacity when you are
taking a large number of pictures.

− Large file sizes are common for high-resolution images, and may take some time
to be transferred to the PC.

Viewing images saves on your PC
A "Remote Camera" folder will be created in the "Bluetooth" folder under "My Documents"
during initial set-up. A folder bearing the same name as the camera will be created in it, and
images will be saved in this folder.

Click the [Explorer] button in the [Remote Camera] window to display the folder where the
images have been saved.

Note
− This window is an example showing pictures when [Filmstrip] has been selected

from the [View] menu in Explorer.
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Using a headset to communicate
Registering the headset

1. Right-click on the Bluetooth icon in the tasktray, then click on [Add New
Connection Wizard].

Note
− Alternatively, you can click on [Start]>[All Programs]>[Bluetooth]>[Bluetooth

Settings], then click on [New Connection] in the [Bluetooth Settings] screen that
has opened.

− The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)]
screen will appear.

2. Turn the headset power on.
Once you have turned on the headset, set the mode to enable a Bluetooth
connection.

Important
The procedure for operating the headset may differ depending on the manufacturer
and model. Please consult your user guide for a detailed description of how to
operate the unit.

3. Confirm that [Express Mode] has been selected, then click on the [Next] button.
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The [Add New Connection Wizard (Searching for Bluetooth Devices)] screen will appear.

Once the device search has been completed, the [Add New Connection Wizard 
(Select a Device)] screen will appear.

4. Select the name of the headset device from the list, then click on the [Next]
button.
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5. Answering with the headset.
If the service has been properly detected, a screen will appear indicating that the
headset is being called, and a tone will accordingly sound in the headset.

Please press the headset switch.

Important
The procedure for operating the headset may differ depending on the manufacturer
and model. Please consult your user guide for a detailed description of how to
operate the unit.

The [Add New Connection Wizard (Configuring (Connecting to Voice Circuit))] screen will
appear, and device configuration will be performed.

Note
− If you are connecting to the headset for the first time, or if another Bluetooth audio

device (for example, the TOSHIBA Speech Recognizer) has not yet been
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registered, the following [Found New Hardware Wizard] screen will appear, from
which you can proceed to install the driver. If another audio device has already
been registered (i.e., the driver has been installed), you can proceed to Step 9
without having to install the driver.

6. Click on the [Next] button.

The [Install Hardware] screen will appear.

7. Click on the [Continue Anyway] button.
The following screen will appear automatically. You may disregard it and click on the
[Continue Anyway] button.
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The [Add New Connection Wizard (Completing the Found New Hardware Wizard)]
screen, which is the final screen of the installation wizard, will appear.

8. Click on the [Finish] button.

Once driver installation is complete, the [Add New Connection Wizard (Enter Connection
Name)] will appear.

9. Confirm the information you have entered, and click on the [Next] button.
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The [Add New Connection Wizard (Completing the Add New Connection Wizard)] 
screen will appear.

10. Click on the [Finish] button.

The configuration information will be registered, and an icon will be displayed in the
[Bluetooth Settings] screen.

Making a connecting to the headset
You can make a connection to the headset from an icon that has been registered in
[Bluetooth Settings].

Important
Before making a connection to the headset, please check that you have turned on the
headset's power, and it has been enabled for a Bluetooth connection. Please ensure
that the following audio-related applications have been closed before you connect the
headset to your PC.

o Windows Media Player, BeatJam, InterVideo WinDVD and other music/audio
playback software

o Windows Messenger and other e-conferencing software
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o LaLaVoice and other voice-recognition software

If you wish to use these applications, please terminate the headset connection before
you launch them.

1. Right-click on the headset icon, then click on [Connect].

2. Answer with the headset.

A screen will appear indicating that the headset is being called, and a tone will
accordingly sound in the headset. Please press the headset switch.

If the connection has been properly established, the icon's appearance will change to
indicate a connected state.
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You may now launch conferencing and voice-recognition software and use the headset.

Disconnecting from the headset
Please follow the steps below to disconnect from the headset.

1. Right-click on the headset icon in the [Bluetooth Settings] screen, then click on
[Disconnect].

A message will appear, requesting confirmation that you wish to disconnect. Click on the
[Yes] button. The icon on the [Bluetooth Settings] screen will appear as shown below,
indicating that the device has been disconnected.
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Chapter 5
Advanced features

Making a device undiscoverable to other users
1. Right-click on the Bluetooth icon in the task tray, and then click on

[Device Properties].

The [Device Properties] window will appear.

2. Select [Non-discoverable mode] in [Discoverability mode] under the
[Mode] tab, and then click on the [OK] button.

5
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Your device will now be undetectable by other users, even when they search for other
devices.
Note
− Other devices are still able to establish connections with your device even if you 

have enabled the Non-discoverable mode. Please enable "Non-connectable
mode" if you wish to reject connections from other devices.

Encrypting the content of your transmissions
Since Bluetooth communication is conducted wirelessly, there is always the possibility
that a third party may be able to intercept your transmissions.
You can use encryption to render the content indecipherable to anyone who manages
to intercept it.

Important
Encrypting your transmissions will still not guarantee complete security.
Accordingly, please be aware that transmitting data is conducted with an element of
risk for the user.

1. Right-click on the Bluetooth icon in the task tray, and then click on
[Device Properties].
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The [Device Properties] window will appear.

2. Select [Link Level Enforced Security] in [Security Mode] under the [Mode]
tab, put a check next to [Encryption], and then click on the [OK] button.

Note
− Once you have configured the security mode, a window will appear when

you first make a connection to another device, prompting you to enter a
Bluetooth passkey (PIN code). Please click on the [OK] button after you
have entered the passkey.
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The window in which you enter the passkey will not appear once you have connected
more than two times to the device.

Changing the default connection
The "default connection" refers to the dial-up connection configured for use whenever
a connection is made to the Internet.
If several connections have been registered, you can change the default connection by
following the procedure below.

1. Start Internet Explorer.

2. Click on [Tools]→[Internet Options...].

The [Internet Options] window will appear.

3. Click on the [Connections] tab.
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In this window, "Direct Connection" is set as the default, and "Never dial a
connection" has been selected.

Change the settings so that "London A" will always be dialled when you connect to
the Internet.

4. Select "Always dial my default connection".
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5. Click on "London A", and then click on the [Set Default] button.

"London A" has been changed to the default connection.
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Manually creating a virtual Bluetooth COM port
In order for a PC to connect to and communicate with a Bluetooth device, the
Bluetooth Utility will create a gateway for data to be exchanged between the respective
devices. This gateway is known as a "port" (or "virtual COM port").

Since one virtual COM port will be allocated to each device, trouble-free
communication will still be possible even if several devices are being used.

When you use the Bluetooth Utility, a virtual COM port will be automatically created on
set-up; however, virtual COM ports can be created manually if so needed.

Clients and servers
When Bluetooth communications are performed, there will always be a "client/server"
relationship between the various devices. A "client" is a device that sends certain
requests to another device, while a "server" is a device that provides a service on
receipt of such requests from another device.

For example, when a PC issues a print command to a wireless printer, the PC
functions as the client, while the printer functions as the server.
When a PDA or other device attempts to receive files located on a PC by means of file
transfer protocol, the PC functions as the server, while the PDA functions as the client.

Virtual Bluetooth COM ports can be created both for clients and servers.
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− Bluetooth virtual COM port for a client
Virtual COM port used when your device is the client, and requests are sent to
another device.

− Bluetooth virtual COM port for a server
Virtual COM port used when your device is the server, and requests are received
from another device.

Creating a virtual COM port
1. Click on the [Printers and Other Hardware] icon in the Control Panel.

The [Printers and Other Hardware] window appears.

2. Double-click on the [Bluetooth Local COM] icon.
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The main Bluetooth Local COM window will appear.
Note
− Even when the Control Panel appears in Classic view, please simply click on the

[Bluetooth Local COM] icon.

o No such distinction between viewing formats exists in Windows 2000.

3. Click on the [Add...] button.
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The [Bluetooth Local COM Wizard] window, from where you can create a virtual
COM port, will appear.

Start from this window when creating Bluetooth virtual COM ports for either servers
or clients.

Deleting a virtual COM port
Note
− You can only delete virtual COM ports created by the Bluetooth Local COM utility.

1. Select the port you wish to delete from the [Bluetooth Local COM] window,
and then click on the [Delete] button.
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A message will appear asking you to confirm that you wish to delete the port.

2. Click on the [Yes] button.

The port will be deleted.

3. Click on the [OK] button.



155

Chapter 6
Troubleshooting

General operation of the Bluetooth Utility
Bluetooth Manager
Q: Bluetooth icon does not appear in task tray.

•  If the Bluetooth icon does not appear in the task tray, Bluetooth Manager will not
be active, which will prevent you from being able to use any of the functions of
the Bluetooth Utility.
Start the utilities as instructed below to enable Bluetooth Manager to start
automatically and allow all functions to be utilized.

Bluetooth Settings
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings]

Remote Camera
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Remote Camera]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Remote Camera]

Wireless File Transfer
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer]

Q: Unable to turn on Bluetooth.

6
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•  If the wireless communication switch on your PC has been turned off, the
message below will appear, and you will not be able to turn the power on from
Bluetooth Manager.

  Please confirm whether the wireless communication switch has been turned on.

Bluetooth Settings
Q: Clicking on the [New Connection] button brings up the message "Unable to prepare
Bluetooth."

•  The wireless communication switch is turned off.
Please switch it on.

Q: Remote device(s) cannot be detected
•  The other device(s) may have been set to Non-discoverable mode.

Please check the mode settings on the device.

Q: Services on a remote device are undiscoverable
•  The other device may be using a profile that is not supported by the Bluetooth

Utility. Please check the profile being used on the other device.

•  The following profiles are compatible with Bluetooth Settings.

DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP

Devices running profiles other than those above will not be able to be registered
with Bluetooth Settings

Bluetooth Information Exchanger
Q: Bluetooth Information Exchanger icon does not appear on Desktop

•  Bluetooth Information Exchanger is not active. Please follow the procedure
below to start the utility.

1. Right-click on the Bluetooth icon in the task tray

2. Click on [Options] > [Enable Bluetooth Information Exchanger], and
then check [Enable Bluetooth Information Exchanger]
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The Bluetooth Information Exchanger icon will appear on the Desktop.

Q: Transfer failed when sending a file using the right-click menu.
•  FTP or OPP are the sending profiles available when you select a file, right-click

it, and then click on [to Bluetooth] to send it.
If the destination device does not support either of these profiles, you will not be
able to send files using the right-click menu.

File transfer will also be unsuccessful if you use FTP to send a file to a device
that only supports OPP.
In such cases, please click on [Bluetooth] > [Profiles] from [Bluetooth
Information Exchanger], and enter the settings shown under Transfer mode.

Q: Cannot open shared folder on other device with "File Transfer".
•  The other device may have a certain security level enforced (Non-connectable

mode etc). Please confirm the security settings of the other device.
Please enter the correct password if you are asked to enter one.

Remote Camera
•  See "Using a camera"

Bluetooth Local COM
Q: Cannot add port

•  A maximum of 64 virtual COM ports can be added. You will be unable to add
another port if 64 ports have already been configured.

Using a wireless modem station
Q: Modem station cannot be detected.

•  If the modem station is connected to and is being used by another device, the
modem station will be undetectable even if you search for it.

Q: Cannot connect to modem station
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•  If the modem station is connected to and is being used by another device, no
other device will be able to connect to the modem station.

Q: Bluetooth passkey entry failed

•  The Bluetooth passkey (PIN code) comprises a sequence of alphanumeric
characters, with the letters able to be rendered in upper and lower case.
If [Caps Lock] is on, the Bluetooth passkey may not be able to be entered
correctly.

Q: Cannot connect to telephone line

•  Please ensure that the telephone cable is connected from the socket to the
"LINE" terminal on the modem station.

Note
− If the telephone cable has come loose because it has not been fully inserted

into the socket, the resulting poor contact may prevent data from being
transmitted accurately.

− Communication will be impossible if the interior of the cable has been
broken. Please replace the cable with another one.

•  Please ensure that the two slide switches on the underside of the main unit
have been set to the "NORMAL" and "MODEM" positions respectively.

Q: Cannot connect to the Internet

•  The telephone number of the connection (i.e., the telephone number for the
access point of your Internet service provider) may not be correct. Please check
the telephone number.

•  The user ID and/or password for the provider with whom you have signed up
may have been entered incorrectly. Please check the user ID and password.

•  The default connection may have been configured with different settings. Please
set the connection configured for mobile telephone use as the default
connection.

•  When you place a call using a company switchboard or other exchange, the
system may require you to enter a "0" before the telephone number itself.
Please check the type of telephone line you are using.

Q: Cannot send or receive faxes

•  Once you have registered a wireless modem station as your fax server, you will
need to enter the fax settings from the [Printer and Faxes] window in the Control
Panel.
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Please refer to "Using a modem station for fax transmissions" for information on
the configuration procedure.

•  The telephone number of the fax destination may have been entered incorrectly.
Please check the telephone number.

•  If the setting under COM Auto Connect Settings has been set to "Off", a
connection will not automatically be established with the modem. Please
connect to the modem manually.

•  When you place a call using a company switchboard or other exchange, the
system may require you to enter a "0" before the telephone number itself.
Please check the type of telephone line you are using.

•  The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the
[Fax] icon, and then click on [Properties].

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use,
and then click on [Properties].
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3. Select the [Send] tab, and then confirm that "Enable device to send"
has been checked.

4. Select the [Receive] tab, and then confirm that "Enable device to
receive" has been checked (when you wish to receive faxes).
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5. Click on the [OK] button.

Using an access point
Q: Access point cannot be detected.

•  If the access point is connected to and is being used by another device, the
access point will be undetectable even if you search for it.

Q: Cannot connect to access point.
•  If the access point is connected to and is being used by another device, no

other device will be able to connect to the access point.

Q: Cannot connect to LAN.
•  The LAN cable may not be properly connected to the access point. Please

check the connection status.

Note
− If the LAN cable has come loose because it has not been fully inserted into

the socket, the resulting poor contact may prevent data from being
transmitted accurately.

− Communication will be impossible if the interior of the LAN cable has been
broken. Please replace the cable with another one.

•  The access point may not have been configured correctly, and may not be able
to maintain the connection to the LAN.
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Please refer to the product instruction manual for information on how to
configure your access point.

Q: Cannot connect to the Internet.
•  If you are using a LAN to connect to the Internet, the LAN environment of the

company or location where you are trying to establish the connection may
require you to connect via a proxy server.

Using a mobile telephone
Q: Mobile telephone cannot be detected.

•  If the mobile telephone is connected to and is being used by another device, the
mobile telephone will be undetectable even if you search for it.

Q: Cannot connect to mobile telephone.
•  If the mobile telephone is connected to and is being used by another device, no

other device will be able to connect to the mobile telephone.

Q: Cannot send images to mobile telephone.
•  Please use the appropriate transfer method, according to the profiles supported

by your mobile telephone.

If OPP is supported: right-click on a file to send it

If BIP is supported: use "Image transfer" under Bluetooth Information Exchanger
to send images

Q: Cannot connect to the Internet.
•  The telephone number of the connection (i.e., the telephone number for the

access point of your Internet service provider) may not be correct. Please check
the telephone number.

•  The user ID and/or password for the provider with whom you have signed up
may have been entered incorrectly. Please check the user ID and password.

•  The default connection may have been configured with different settings. Please
set the connection configured for mobile telephone use as the default
connection.

Q: Cannot send or receive faxes.
•  Once you have registered a mobile telephone as your fax server, you will need

to enter the fax settings from the [Printer and Faxes] window in the Control
Panel.
Please refer to "Using a modem station for fax transmissions" for information on
the configuration procedure.
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•  The telephone number of the fax destination may have been entered incorrectly.
Please check the telephone number.

•  If the setting under COM Auto Connect Settings has been set to "Off", a
connection will not automatically be established with the modem. Please
connect to the mobile telephone manually.

•  The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the
[Fax] icon, and then click on [Properties].

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use,
and then click on [Properties] .
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3. Select the [Send] tab, and then confirm that "Enable device to send"
has been checked.

4. Select the [Receive] tab, and then confirm that "Enable device to
receive" has been checked when you wish to receive faxes).
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5. Click on the [OK] button.

Using a PDA
Q: Cannot make an ActiveSync connection.

•  Please confirm that you have installed ActiveSync v3.7 or higher on your PC.

•  ActiveSync is installed to COM7 as a default. Please refer to "Synchronizing
data with a PDA" and re-configure your ActiveSync connection.
If a port other than COM7 has been used, please amend the ActiveSync
connection settings accordingly.

Q: Cannot locate a saved file.
•  The type of file sent to your PDA, as well as the profile used to send the file,

may affect where folders saved on your PDA are located.

Examples:
Images transferred to your PDA using "Image transfer" > saved in the "Image
transfer" folder
Images transferred to your PDA using "File transfer" > saved in the "Shared
folder"

Using a camera
Q: Camera cannot be detected.
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•  If the camera is connected to and is being used by another device, the camera
will be undetectable even if you search for it.

Q: Cannot connect to camera.
•  If the camera is connected to and is being used by another device, no other

device will be able to connect to the camera.

Q: Images from the camera can be displayed, but no pictures can be taken.
•  The memory card in the camera may be full.

Please make a backup of all your necessary data on alternative media, then
delete the images from the memory card, and ascertain how much free space
remains.

Q: Camera images do not appear in window.
•  The camera may not have been set to remote camera mode (image browse

mode, configuration mode, etc).

Certain cameras will end the Bluetooth connection automatically if you change
the settings in a mode other than remote camera mode. Please re-connect to
the camera when you next wish to use the device in remote camera mode.

Using a Bluetooth Headset
Q: Bluetooth Headset cannot be detected.

•  If the Bluetooth Headset is connected to and is being used by another device,
the Bluetooth Headset will be undetectable even if you search for it.

Q: Cannot connect to Bluetooth Headset.
•  If the Bluetooth Headset is connected to and is being used by another device,

no other device will be able to connect to the Bluetooth Headset.

•  A Bluetooth connection will be impossible if the Bluetooth Headset is connected
to a power adaptor.
Please remove the power adaptor and re-connect.

Q: Sound cuts out/cannot hear anything.
•  Using a Bluetooth headset with other Bluetooth devices may cause problems

such as interruptions in sound, reduced transfer speed or failure during file
transfer, and disconnection of the other Bluetooth devices. We strongly
recommend using a Bluetooth headset on its own and not in connection with
other Bluetooth devices.

•  Please confirm that the Bluetooth Headset is being operated correctly (for
example, ensure that the correct mode (audio or communications) mode has
been selected).
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•  Please confirm that the voice file or CD is being played back normally on your
PC.

•  Please check the volume settings on your Bluetooth Headset and PC.

•  If Windows Media Player or another audio-related application is active when you
try to connect your Bluetooth Headset, you may find it impossible to connect
properly to the Bluetooth Headset, or even to use it at all.
Please start such applications after you have connected to the Bluetooth
Headset.

Registering your product and getting assistance

If you need assistance, you should consider contacting the company that sold you the
Bluetooth USB Adapter.
We encourage you to register your product and to notice the many support options
available from Zoom.
− Visit our Web site at www.zoom.com and select Technical Support. From here

you can register your device, contact our technical support experts, use our
intelligent database SmartFactstm , and/or get warranty information.

− Call our support office by dialing the US number 561-997-9686 or the UK number
+44 08707200090.

http://www.zoom.com/
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Appendix A
Regulatory information

FCC Warning
Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's
authority to operate the equipment. Caution: For the purpose of satisfying FCC RF exposure compliance requirements,
antennas should be positioned in such a way that a separation distance of at least 20cm is maintained between the
transmitter's radiating structures and the body of the user or nearby persons.

FCC Part 15 Emissions Statement
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

− Reorient or relocate the receiving antenna.

− Increase the separation between the equipment and receiver.

− Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

− Consult the dealer or an experienced radio/TV technician for help.

Department of Commerce End User Statement
This item falls under the jurisdiction of the Department of Commerce, and as such, the requirement set forth in section 740-
17 of the Export Administration Regulation must be complied with. See the following Web sites for more information:

Bureau of Export Administration

http://www.bxa.doc.gov/DPL/Default.shtm

http://www.bxa.doc.gov/Entities/

A
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Code of Federal Regulations
http://www.access.gpo.gov/nara/cfr/index.html

Federal law prohibits the sale or distribution of certain products to certain individuals and organizations. Denied persons or
organizations may not, directly or indirectly, participate in any way in any transaction involving any commodity, software or
technology exported or to be exported from the United States that is subject to Export Administration Regulations. The
above Web sites provide a detailed list of individuals and organizations that have been determined to present an
unacceptable risk of diversion to developing weapons of mass destruction or missiles used to deliver those weapons.
It is recommended that this unit be used with a listed computer.

Declaration of Conformity

Manufacturer
Zoom Technologies, Inc., 207 South Street
Boston, MA 02111  USA  /  617-423-1072
www.zoom.com

Brand Bluetooth USB Adapter Class 1
Type Model 4310B

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

73/23/EEC – LVD EN 60950-1: 2001
IEC 60950-1: 2001

89/336/EEC – EMC EN 301 489-1 V1.4.1:8/2002
EN 301 489-17 V1.2.1:8/2002

99/5/EC - Radio EN 300 328-1 V1.6.1:2004

The following Notified Body has been consulted in the Conformity Assessment procedure:

Number: 1177  Timco Engineering Inc., 849 NW State Road 45, Newberry, FL 32669

Declaration of Conformity

Manufacturer
Zoom Technologies, Inc., 207 South Street
Boston, MA 02111  USA  /  617-423-1072
www.zoom.com

Brand Bluetooth USB Adapter Class 2
Type Model 4320A

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

73/23/EEC – LVD EN 60950-1: 2001

89/336/EEC – EMC EN 301 489-1 V1.5.1:2004
EN 301 489-17 V1.2.1:2002

99/5/EC - Radio EN 300 328-1 V1.6.1:2004

Andy Pollock Director, Hardware
Engineering 12 Jan 2006
4310B/TF, Boston, MA, USA

Andy Pollock Director, Hardware
Engineering 12 Jan 2006
4320A/TF, Boston, MA, USA

http://www.zoom.com/
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Declaration of Conformity

Manufacturer
Zoom Technologies, Inc., 207 South Street
Boston, MA 02111  USA  /  617-423-1072
www.zoom.com

Brand Bluetooth PC Card
Type Model 4312A

The manufacturer declares under sole responsibility that this equipment is compliant to Directive 1999/5/EC via the
following. This product is CE marked.

73/23/EEC – LVD EN 60950-1:2001

89/336/EEC – EMC EN 301 489-1 V1.4.1:2002
EN 301 489-17 V1.2.1:2002

99/5/EC - Radio EN 300 328 V1.6.1:2004

NOTICE
This document contains proprietary information protected by copyright, and this User Guide and any
accompanying hardware, software, firmware, and documentation are copyrighted. No part of this
document may be photocopied or reproduced by mechanical, electronic, or other means in any form.

The manufacturer does not warrant that the hardware will work properly in all environments and
applications, and makes no warranty or representation, either expressed or implied, with respect to the
quality, performance, merchantability, or fitness for a particular purpose of the software or
documentation. The manufacturer reserves the right to make changes to the hardware, software, and
documentation without obligation to notify any person or organization of the revision or change.
All brand and product names are the trademarks of their respective owners.

Microsoft® and Windows® are registered trademarks of Microsoft Corporation.
© Copyright 2006
All rights reserved.

Andy Pollock Director, Hardware
Engineering / 12 Jan 2006
4312A/TF, Boston, MA, USA
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